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 Does it use the standard OCHA template? 

The snapshot template is available on 
https://ochanet.unocha.org/OS/HQ_Branches_Office
s/CISB/OCHA_Templates/Map%20Templates/Forms
/AllItems.aspx 

It is not mandatory to use the snapshot template but 
at least the generic OCHA visual template with the 
blue banner must be used.  

 Is the file in CMYK? 

Certain RGB colors that you can see on your monitor 
or camera (in particular, bright vibrant colors) simply 
cannot be replicated in printing. Make sure to save 
your work in CMYK to ensure the colors you see on 
your monitor will more closely match the final printed 
piece. 

In ArcGIS, when your map is ready to be exported, 
go to: 

1. File > Export Map 

2. Toggle open the "Options" menu 

3. Click on "Format" tab 

4. Select "CMYK" under "Destination 
Colorspace" 

In Adobe Illustrator: 

1. File > Document color mode > CMYK 

 Does it use the standard OCHA colours? 

The OCHA's corporate blue is CMYK 90,57,0,0. Use 
the colour palette provided in the graphics style book 
p.5. Resist the temptation to add too many colours. 
Effective data visualizations rely on a clear and 
deliberate use of colour to help the reader digest the 
information quickly. Do not distract the reading by 
adding too many colours. 

 Does it use the standard OCHA fonts? 

Arial is the font of choice for OCHA infographics, as it 
is distributed with all major computer operating 
systems. Using Arial guarantees that products will 
appear as originally designed, regardless of what 
software or computer the reader is using. The only 
exception is using Times New Roman for 
rivers/watershed labels). 

 Are all data used in the snapshot 
sourced? 

Make sure to source all data used in the snapshot for 
transparency of information and proper 
acknowledgment of partners.  

 Does it use the official UN map 
disclaimer? 

EN The boundaries and names shown and the designations 
used on this map do not imply official endorsement or 
acceptance by the United Nations. 

FR Les frontières et les noms indiqués et les désignations 
employées sur cette carte n'impliquent pas reconnaissance 
ou acceptation officielle par l'Organisation des Nations 
Unies. 

ES Los Límites y los nombres y las designaciones que figuran 
en este mapa no implican su apoyo o aceptación oficial por 
las Naciones Unidas. 

 

Jammu and Kashmir 

EN Dotted line represents approximately the Line of Control in 
Jammu and Kashmir agreed upon by India and Pakistan. 
The final status of Jammu and Kashmir has not yet been 
agreed upon by the parties. 

FR La ligne en pointillé correspond approximativement à la 
Ligne de contrôle du Jammu et Cachemire dont ont convenu 
l'Inde et le Pakistan. Les parties n’ont pas encore convenu 
du statut définitif du Jammu et Cachemire. 

ES La línea de puntos representa aproximadamente la Línea de 
Control en Jammu y Cachemira convenida por la India y el 
Pakistán. Las partes no han llegado todavia a un acuerdo 
sobre el estatuto definitivo de Jammu y Cachemira. 

 

Sudan-South Sudan 

EN Final boundary between the Republic of Sudan and the 
Republic of South Sudan has not yet been determined. 

FR La frontière entre la République du Soudan et la Rèpublique 
du Soudan du Sud n’a pas été déterminée. 

ES Las fronteras definitivas entre la República del Sudán y la 
República de Sudán del Sur no se han determinado todavía. 

 

Abyei 

EN Final status of the Abyei area is not yet determined. 

FR Le statut définitif de la zone d'Abyei n'a pas encore été fixé. 

ES La condición jurídica definitiva de la zona de Abyei aún no 
se ha determinado. 

 

Humanitarian snapshot checklist 
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 Is the PDF exported properly, without 
hidden layers and in the smallest file size? 

Invisible layers will magically reappear when an 
Illustrator PDF is loaded in certain non-Adobe 
products (for example, the Mac PDF reader Preview). 
To avoid this issue, deselect “Preserve Illustrator 
Editing Capability” and “Create Acrobat Layers from 
top-level Layers” in the "Save Adobe PDF" dialog: 

1.  File > Save as and select "Adobe PDF" in 
the "Save as type" and click "Save". 

2. A new dialog will pop-up. Under "General", 
deselect "Preserve Illustrator Editing 
Capabilities" and "Create Acrobat Layers 
from Top-Level Layers". 

This will reduce the file size by more than half as 
well.  

If you are using some images in the file, click 
“Compression” and play with the resolution size to 
reduce the file size.

 

Editorial 
Step back, look at the piece as a whole, and ask 
yourself, "Does it work?" The design and content 
must work together to meet a well-defined goal.  

 Does the title intrigue, inform and invite 
readers in? 

Avoid using acronyms and use a title that is 
meaningful to everyone. Do not simply use 
“humanitarian snapshot” but be more specific, to 
attract readers (e.g. Iraq: Influx of Displaced People – 
Humanitarian Snapshot). Keep in mind that most of 
websites will only list the title therefore it is crucial to 
have a stand-out and descriptive title. 

 Does it tell one compelling story? 

The aim of the snapshot is to raise awareness of the 
current situation in the country by providing a 
compelling visual story. Before producing it, the 
information management officer should work with the 
public information/reporting officer to determine the 
story line of the month. 

 Does it state the problem/issue and show 
it visually to deliver the message? 

The team should define how the data will be 
presented so that the design communicates the 
essentials of the story’s message without overloading 
audiences with too much information. You can say 
more by saying less. 

 Message is clearly recognizable and 
aligned with OCHA documents (reports, key 
messages).   

 Themes are appropriate to the snapshot 

Some content belongs to the dashboard and not to 
the snapshot: The key difference between the 
dashboard and the snapshot is that the snapshot is a 
map enriched with infographics designed to tell a 
story and visually illustrate a humanitarian situation 
for advocacy, whereas the dashboard aims to provide 
an overview of needs and response data that enables 
the monitoring of progress in the humanitarian 
response over time across and within sectors. 
Therefore, cluster/sectoral information, funding 
information, and needs, response and gaps 
information should not be part of the snapshot but 
dashboard.  

 A snapshot has no more than three main 
themes, preferably one theme. 

Humanitarian Snapshot is a visual product that tells 
the story of an emergency. It is intended to make 
complex information easier to understand, to seize 
the viewer’s attention and to improve the situational 
awareness of the emergency.   

The aim of the snapshot is not to try to show 
everything but only the key issues.  
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Layout
 Good layout  

The overall layout has to be clean and organized. 

The template will help improve the layout and 
organize the content in three columns (left column for 
key messages and figures, middle column with map 
and right column for trends and charts).   

 The sequence of information presented 
makes sense.  

Eye flow:  Understanding how the eye scans a page 
will allow you to control the presentation sequence in 
getting your message out. Though this is somewhat 
culturally dependent, in general, one reads in a "Z" 
path, beginning at the upper left corner, across the 
top and down diagonally to the lower left and then to 
the right. The information that needs to be prominent 
must be on top and the less important is presented 
on the bottom right.  

 Good visual hierarchy 

The eye needs a single place to focus and rest. The 
dominant element will capture attention. Make sure 
you control which element this is and how it relates to 
the others within the document.  Emphasis and 
proportion are related since the size of the various 
items impacts which we look at first. The larger, 
darker items carry the most weight. Enlarge and 
darken elements that you would like to make 
prominent and use a smaller size and lighter colour 
for elements that are secondary. By properly ordering 

the visual hierarchy, the most relevant important 
information will be the most visually prominent. 

 Good balance 

A page must not be too cluttered, nor should it have 
too much empty space. Do not fill each bit space: the 
effective use of white space adds a great deal to 
readability. White space is beautiful! 

 All elements are aligned and follow a grid 
system 

A grid system is a structure comprising a series of 
horizontal and vertical lines that intersect and are 
then used to arrange content. A grid system is a way 
of providing a background that designers can work 
with to structure and present content and imagery in 
a readable and manageable way. The grids provide 
organization, subdivide content, establish hierarchy 
and create balance.  

Proper alignment will make your designs visually 
more appealing and will also make it easier for users 
to scan over a page, promoting a calmer reading 
experience. Alignment also allows us to make 
conscious decisions about where elements are 
placed and how they interact with each other. 
Creating good alignment bridges the visual gap 
between every element in your design, helping us to 
create relationships between the elements that we 
have. Otherwise, we’d have a design that has blocks 
of text and images all over the place, making little 
sense with no sense of structure.

Text
 The introduction text must be a lead to the 
visual and must work together.  

 Spelling and grammar errors are absent. 

Ask your reporting or public information colleagues to 
editorially review the text. 

 All acronyms used are explained. 

Most of the readers are not familiar with UN or 
humanitarian jargons.  

 No use of very technical language, 
acronyms or UN jargon.  

The text must be short, concise and clear. Please 
consult your public information officer/reporting officer 
for their support. 

 Use rounded numbers 

Round the number to hundreds or thousands as 
often, the numbers are changing regularely. 

 Use of consistent Upper/lower case 

Only the main title can be title case (all words 
capitalized). e.g. Iraq: Influx of Displaced People – 
Humanitarian Snapshot. The rest must be sentence 
case (only the first word is capitalized, except for 
proper nouns), including graphic titles.   

Visual elements 

 Good design 

The data and story are visually presented in a 
beautiful and appealing way 

A good snapshot focuses on finding the right color 
scheme, readable fonts, cool graphics, icons, 
characters and clever ways to illustrate digestible 
information. 
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 All the visual elements relate back to the 
introduction text. 

If the data does not support the story, remove it. For 
example, if funding is not an issue, there is no reason 
to add it in the snapshot as it will be part of other 
products such the dashboard. Use only data that 
describes the key messages and eliminate any 
elements that do not directly contribute to the 
understanding of the story. 

 Data must be reliable and timely. 

Remove old information that is not pertinent anymore 
and focus only on key issues. 

The data gathered for the snapshot should be from 
reputable sources and represent the latest accurate 
statistics available at the time. Use Governmental 
and UN data, followed by humanitarian partners. 
Avoid using media/news sources. 

There should be no discrepancy in the figures 
presented in the snapshot and other most recent 
documents.  

 

Chart
 Use the right type of chart.  

There are different ways to visualize data and 
different types of visual representations. The different 
types are covered in the graphics style book. Choose 
a chart type that will be easy for your readers to 
understand and don't use an over-complicated chart 
type. The simpler, the better. 

 Create clear graphic titles. 

Don’t leave your readers guessing about what the 
data items represent. Include time increments and 
units. 

 The chart must tell a story. 

The chart has good proportion, clear visual hierarchy 
and highlights the most important information. The 
chart must show something worthwhile. Use charts to 
highlight the important comparisons you want to 
make and use them sparingly to maximize their 
effectiveness. Use visual hierarchy to highlight 
elements. 

 The chart must be simple 

Simplify the chart by removing all unnecessary 
elements and keep the design minimal so the data 
can speak for itself. 

[for a bar chart] 

 Remove backgrounds and borders in chart 
elements can distract the viewer.  

 Remove special effects like shading and 
shadows.  

 Un-bold, un-italicize and un-underline all text, 
except for elements that you would like to 
highlight.  

 Omit axes and baselines when data values are 
labelled.  

 When axis lines are present, it is not necessary to 
label each data value. However, it can be useful 
to highlight the final value or other important data 
points.  

 Start at the zero baseline! No exception. Do not 
clip the axis in order to highlight disparities at the 

top of the axis. Instead, try recalculating your data 
as percentages, or try another type of chart.  

 Clearly denote currency or units.  

 Convert your data to rounded, easily digestible 
values for chart labelling. 

 Sort your data before charting so that readers can 
easily compare. 

 Include the data sources in the metadata. 

[for a  line chart] 

 Don’t use the dashed lines and shape markers 
provided by excel to differentiate each line. You 
can use solid lines exclusively by limiting the chart 
to four or fewer lines. Varying weights and shades 
do the work of differentiating the lines more 
effectively than distracting patterns and markers. 

 In a single chart, keep the maximum number of 
lines to three or possibly four if the lines are not 
intersecting at many points. The purpose of a 
multiple-line chart is to compare and contrast 
different data series.  

 With four or more data series, an array of 
individual charts can display a pattern and allows 
better comparison among all lines (small multiples 
technic). 

 The most important line should be one colour and 
the other lines should be shades of a second 
colour.  

[for a pie chart]  

 Start at 12 o’clock, not 3 o’clock 

 Sort the data 

 Never chart segments clockwise from smallest to 
largest; otherwise, the least important segment 
has the most prominent position. Place the largest 
segment at 12 o’clock on the right to emphasize 
its importance 

 The best way to order the rest of the segments is 
to place the second biggest slice at 12 o’clock on 
the left; the rest would follow clockwise. The 
smallest slice will fall near the bottom of the chart, 
in the least significant position.  This way, there is 
also more room for labeling the smallest slices. 
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 A pie should not have more than five slices. If 
there are more than five, combine the smaller and 
less significant segments to create a fifth slice and 
label it “Other”. If the segments have to be 
represented separately, use a stacked or 
segmented bar chart instead. 

 Just like in bar and line charts, direct labeling 
helps the reader to quickly identify individual 
segments and focus on the comparison between 
them. 

 Keep the shading simple. The goal is for the 
reader to compare the size of any segment to the 
whole pie efficiently. 

 Add a short narrative that explains the 
chart for stronger message. 

 Show trends. 

Provide contextual information rather than just 
focusing on the current situation.  

Map 

 The map is easy to read. 

If the map is too busy and difficult to read, simplify it 
by removing unnecessary elements. Is it necessary 
to have all boundaries and all labels? Keep only the 
most relevant ones and remove the rest or make 
them less prominent by using lighter colours and 
smaller symbols. Create a visual hierarchy. 

Remove the shaded relief that makes the map 
difficult to read. Remove shadows and special effects 
to simplify the reading.  

 The map is the best visualization type 

Some information will be better illustrated on a chart 
instead of on a map. 

 The map follows OCHA's cartographic 
representation. 

The best practice in mapping is to use polyline to 
represent the boundary. The use of outline of polygon 
is incorrect as you won't be able to represent "dash" 
or "dotted" lines correctly. 

 Are the disputed areas and their 
representation correct? 

Check annex 7 of the graphics style book for proper 
representation of disputed areas.  

 Good use of icons. 

Do not overuse the icons. Simple circle or square 
would often work better than using a complex icon. 

 All important items represented in legend. 

 


